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Files included on this CD-ROM Contents?

Introduction and shoreline habitat photos

Legend and how to interpret ESI maps

Index map showing ESI map coverages

Seasonality tables

Metadata

For more information about the contents
of this CD-ROM, please continue.
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Contents?

WIN_READ.TXT / MAC_READ.TXT.  These Readme files
explain that Acrobat Reader 3.0 must be installed before the
contents of this CD-ROM can be viewed.

ACROBAT.  This directory contains Adobe Acrobat Reader 3.0
software for three platforms: Macintosh, Windows, and UNIX.
Instructions on downloading the Acrobat Reader are found in
the Readme files under each platform directory.

Directory named according to state (e.g., CALIF, S_CAROL).
This directory contains this Online Guide (GUIDE.PDF) and a
directory called ESI_DATA which contains the Index map, ESI
maps, Seasonality tables, associated Introduction and Legend
files, and a technical file about the actual data used in the ESI
maps.
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Within the ESI_DATA directory are the following files and sub-
directories:

Introduction discussion (INTRO.PDF).  This file is a text
introduction to the ESI Atlas that explains the purpose and
content of the atlas.  It lists animal species in the area, gives
contacts for human-use features such as parks and marinas, and
describes the various shoreline habitats found in the area.

Legend of symbols used, and discussion on how to interpret
ESI maps (LEGEND.PDF).  This file tells what each color and
symbol used in the ESI maps stands for and gives tips for
interpreting the map information.
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(cont.)

Index map (INDEX.PDF).   This file is a map of the entire state
with the ESI map coverages outlined.  The coverage boxes are
linked to the screen resolution ESI map pages.  Just click the box
to jump to the associated ESI map.

Seasonality tables (SEASON.PDF).  This file lists the seasonal
species data associated with each ESI map.  The table shows each
species present in the area, whether they are on any State or
Federal threatened or endangered species lists and the level of
concern, which months the species is present, and the times of
various life stages such as nesting or spawning.

The map titles at the top of the page are linked back to the actual
ESI map, so to view the ESI map associated with the table, click
the title.
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(cont.)

Screen-resolution ESI maps (LOWRES).   This directory
contains the 72-dpi screen resolution ESI maps.  These are the
maps that are accessed through the Index map and that are
associated with the Seasonality tables.

The titles of these maps are linked to the Seasonality tables, so to
see the seasonality data for a map, click on the map title.

High-resolution ESI maps (HIRES).  This directory contains the
300-dpi ESI maps.  They are the same maps as the 72-dpi maps
except at a higher resolution.  They were included so that high-
quality printouts of the maps could be produced.

These maps are not linked to any of the other files.
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(cont.)

Document on how the data was compiled and digitized
(METADATA.PDF).   This file provides the technical
documentation about the data shown on the ESI maps.  It details
the quality standards for the data, discusses how the spatial data
was organized and referenced, and gives complete information
about the entities and attributes portrayed on the maps.
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Viewing the Index map.  Click on the "Index map" text on the "Files
Included on this CD-ROM" section of this guide.  From there, you can
link to the individual ESI maps by clicking in the coverage boxes.

Returning to the Index map.  Click         from the toolbar to return to the
Index map from an ESI map.  (NOTE:  This button returns to the
previous view, so if you zoomed into the ESI map, the button will
return to the unzoomed view.  Click the button again to return to the
Index map.)

Viewing the Seasonality data.  Click the title of the ESI map.

Returning to the ESI map.  Click the map name at the top of the
Seasonality table.



Contents?How to navigate (cont.)
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For an alternate method of navigation where it is possible to keep multiple files open and
to toggle between files using the Window menu, please continue.
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Instead of using the       button, there is an alternate way to navigate
among all of the documents on this CD-ROM, but it requires you to
change a preference in the Reader 3.0 application.  Once this preference
is set, multiple files can stay open at the same time.  To toggle back and
forth, you simply have to select the file you are interested in from the
Window menu.

To change the preference:
 •  Go to the File menu and select Preferences
 •  Choose General
 •  In the dialogue box that opens up, UNCHECK the "Open Cross
     Document Links in Same Window" option.
 •  Select OK.

Once set, the preference will remain, so you will not have to open the
dialogue again the next time you use this CD-ROM.
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Viewing the Index map.  Click on the "Index map" text on the "Files
Included on this CD-ROM" section of this guide.  From there, you can
link to the individual ESI maps by clicking in the coverage boxes.

Returning to the Index map.  Choose "INDEX.PDF" from the Window
menu.

Viewing the Seasonality data.  Click the title of the ESI map.

Returning to the ESI map.  Click the map name at the top of the
Seasonality table.
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To print a page from this CD-ROM, open the file you wish to print and
select "Print" from the File menu.  (For higher quality prints, we
recommend that you print from the high-resolution maps.  See note on
print quality.)  These files can be printed on any Postscript® compatible
printer.  The maps are in 11"x17" format, so you will need to adjust the
map size accordingly to fit your printer output.  Select "Shrink to fit" or
"Fit to page" from your Page Setup menu to automatically scale the map
to paper sizes other than 11"x17".

How to print ESI maps
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The procedure for having the maps printed at a commercial printshop
will vary depending on where you go.  The computer that you use will
need Acrobat Reader 3.0 (included on this CD-ROM).  The computer
must have the 3.0 version because using an older version will cause
irregularities in viewing and printing.

In order to give you a general idea of what might be involved, here are
the printing costs from a local printshop:  We used a computer for 10
minutes, which cost $4.00.  There was a one-time $10.00 charge for the
use of another computer that was used to set up the print files for the
color copier (which was the only machine with 11"x17" color printing
capability).  Then, each color copy cost $1.99, but this charge decreases
with volume.  So to print two pages was about $19.50 (incl. tax), or
about $9.75 per page.  To print 50 pages would have been about $125.00
(incl. tax), or about $2.50 per page.

How to print ESI maps (cont.)
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Contents?Note on Print Quality

This CD-ROM includes a directory of high-resolution maps.  They
contain the same information viewed on-screen, except at a higher
resolution.  The on-screen views use the lower resolution maps because
they open up faster.  The higher resolution maps produce better quality
prints, so we suggest that you print from these.  The high-resolution
maps are in a directory called "HIRES" inside the ESI_DATA directory
inside the State directory.  Please note that these high-resolution maps
are not linked to Seasonality data.

ESI  ATLASES



ESI  ATLASES
Contents?About ESI mapping

The most widely used approach to sensitive environment mapping in
the United States is NOAA’s Environmental Sensitivity Index (ESI)
approach. This approach systematically compiles information in
standard formats for coastal shoreline sensitivity, biological resources,
and human-use resources. The ESIs are an important tool in emergency
spill response, where their use helps to reduce the environmental
consequences of the spill and cleanup efforts.



Contents?About ESI mapping (cont.)

The primary objective of spill response in the United States, after
protecting human life, is to reduce the environmental consequences of
the spill and cleanup efforts.  This objective is best achieved when ESI
maps are used to identify the locations of sensitive resources before a
spill occurs, so that protection priorities can be established and cleanup
strategies developed in advance.  Since their inception in 1979, ESI
atlases have been prepared for most of the U.S. shoreline, including the
Great Lakes, Alaska, Hawaii, and the Trust Territories.

ESI  ATLASES



Contents?

To be effective, sensitive environment mapping must be an integral
component of overall spill planning activities.  Sensitivity maps are not
an end in themselves, rather they are a starting point for prevention,
planning, and response actions. The definitions in the NOAA
sensitivity maps provide guidance that local organizations use to
develop plans. Recently published manuals, including the Mechanical
Protection Guidelines  and the Shoreline Countermeasures  series for
temperate, tropical, Arctic, and freshwater environments are examples
where the ESI definitions are the basis for site-specific planning.

About ESI mapping (cont.)
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There are three general types of information found in ESI maps:
habitats ranked according to geomorphological characteristics,
sensitivity to spilled oil, natural persistence of oil, and ease of cleanup;
biological resources including oil-sensitive animals and plants, with
information at the species level;  and human-use resources, such as
high-use amenity beaches, parks, and marine sanctuaries.  The
intertidal habitat ranking scheme is based on an understanding of the
complete coastal environment, not just the substrate type and grain size.
Key to the rankings is an understanding of the relationships between
physical processes and substrates that produce specific geomorphic
shoreline types and predictable patterns in oil behavior and sediment
transport patterns.  The habitat ranking system has been widely
incorporated into spill decision-making aids including manuals,
matrices, and planning documents.
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Recent work has focused on extending the original methodology for
open coastal areas to inland rivers, and smaller ponds and streams.  The
strategy emphasizes standard map formats for electronic and hard-copy
output.  NOAA is undertaking a comprehensive program to provide
electronic access to new ESI data and to existing data formerly available
only as hard-copy maps.  Our strategy is to make digital ESI data
available on CD-ROM and via the Internet.  Selected ESI atlases will be
available in Portable Document Format for viewing and printing and in
formats appropriate for use with Geographic Information System
software.
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For more information about ESI maps, contact the Hazardous Materials
Response and Assessment Division at:

NOAA / HAZMAT
7600 Sand Point Way N.E.
Seattle, WA 98115

E-mail: library@hazmat.noaa.gov

Or, visit the ESI Home Page at:
http://www-orca.nos.noaa.gov/projects/esi/esiintro.html

ESI  ATLASES
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Florida Department of Environmental Protection
Florida Department of Environmental Protection's (DEP) mission is to
protect, conserve, and manage Florida's environmental and natural
resources.

Hazardous Materials Response & Assessment Division
NOAA’s Hazardous Materials Response and Assessment Division
(HAZMAT) strives to reduce risks to coastal habitats and resources
from oil and hazardous chemical spills and hazardous waste sites.

About the producers



Contents?

Hazardous Materials Response and Assessment Division

HAZMAT draws on two decades of experience in responding to oil spill
emergencies and resolving the often longer-term problems presented by
hazardous waste sites. Equally important are the advances that HAZMAT
scientists have made in improving the state of knowledge about the best
methods to protect the nation’s coastal zone. These advances include
HAZMAT’s internationally recognized CAMEO  program, used by 6,000
organizations worldwide; hydrodynamic and trajectory spill models that
set a national standard for operational presentation of pollutant
movement and spreading in the environment; a watershed-wide
knowledge base; and ecological risk assessments that are critical to
understanding the issues associated with protecting the environment
effectively and for the long term.

About the producers (cont.)
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Contents?About the producers (cont.)

HAZMAT’s response to spill emergencies and waste site problems has
given it a reputation for rapid, well-thought-out, yet cost-effective
environmental protection decisions. Ultimately, HAZMAT strives to
advance the state of knowledge about oil and hazardous materials
interactions and effects in coastal environments by integrating response
efforts with research, development, and international technology transfer.

Every year, millions of gallons of oil and other chemicals spill into
U.S. waters, often caused by marine vessel accidents or leaked by
hazardous waste sites across the nation into environmentally sensitive
habitats. NOAA scientists work closely with Federal On-Scene
Coordinators to respond to about 100 accidental spills and investigate the
consequences of about 400 hazardous waste site releases each year.
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In the last decade, major spill responses have included the 1989 Exxon
Valdez  spill in Prince William Sound; the 1995 Morris J. Berman  spill off
Puerto Rico; the North Cape-Scandia  spill off the Rhode Island coast in
the winter of 1996; and the barge Buffalo 292  spill off Galveston.
HAZMAT’s expertise has also been sought internationally, ranging from
the 1978 Amoco Cadiz  spill off France, the 1991 Arabian Gulf oil well
fires and oil spill, the Katina P  grounding off Mozambique in 1992, to
the Wellborn  spill off Madagascar in 1994.

As with its spill response efforts, HAZMAT’s waste site investigations
encompass virtually every U.S. coast, including Trust Territories, the
Great Lakes, the Gulf of Mexico, Alaska, and Hawaii.
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The following is a selection of products and services that reflect
HAZMAT activity in the pollution response and hazardous waste arena.

HAZMAT provides critical advice on science and other natural resource
issues to the On-Scene Coordinator (OSC) during the Federal
Government’s responses to coastal oil and hazardous materials spills.
Scientific Support Coordinators lead the HAZMAT team at spills,
drawing on the team’s spill trajectory estimates, chemical hazards
analyses, and assessments of the sensitivity of biological and human-use
resources to help the OSC make timely operational decisions.

What got spilled? Where will it go? What resources will it hit? How can
the impacts be reduced? At each spill, HAZMAT’s interdisciplinary
scientific team strives to answer these questions by working with
industry and local governments to select cost-effective, economically
sound cleanup plans.

ESI  ATLASES
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HAZMAT’s unprecedented, multi-year Exxon Valdez  spill response
illustrates NOAA’s unique ability to combine operational, real-time
response with useful research. NOAA scientists were on-scene within
hours after the Exxon Valdez  spilled nearly eleven million gallons of
crude oil into Prince William Sound, Alaska on March 24, 1989. NOAA’s
work in 1989 during the operational phase of the spill response laid the
foundation for the ten-year shoreline impact studies that began in 1990.
These studies evaluate intertidal and shallow subtidal habitat impacts
from oiling and shoreline treatment, and assess the influence of oil and
mechanical treatment actions on the nature and rate of shoreline
recovery. Changes in the chemical properties of oil stranded on
shorelines are also being investigated.

Each week, HAZMAT scientists apply the knowledge from this and
other response research to help minimize the environmental
consequences of spills.

ESI  ATLASES
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HAZMAT works to redress environmental effects of hazardous waste sites
on coastal and marine waters. HAZMAT coordinates consensus with other
Federal and State natural resource trustees to ensure that the proposed
actions are environmentally beneficial, scientifically sound, and feasible.
HAZMAT Coastal Resource Coordinators, liaisons between NOAA and
EPA for Superfund-related trustee activities in seven EPA regions, help
EPA to establish the environmental remedy for each site that will best
protect and restore the resources that have been damaged. They help EPA
identify and assess risks to coastal resources from hazardous waste sites
and to develop cost-effective strategies to minimize those risks. The
program annually addresses over 400 sites in coastal areas on the National
Priorities List. HAZMAT also conducts applied research and technology
transfer. Specific areas of expertise include pioneering work in ecological
risk assessment, wetlands function/restoration, and sediment toxicity
investigations. These efforts improve environmental assessment,
remediation, and mitigation techniques at coastal hazardous waste sites.
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The management of complex watershed issues is enhanced by the ability
to examine and display varied combinations of information
at different spatial scales. HAZMAT designed its watershed projects to
give coastal resource managers information and tools to support
decision-making for site remediation, dredging and disposal of
contaminated sediments, and habitat restoration issues. The watershed
projects collect and organize available watershed-wide information on
contaminant sources, sediment contaminant and toxicity data, natural
resources, and potential habitat restoration projects; and prepare
geographical presentations of the information useful in resolving
important watershed-wide issues. HAZMAT has developed a database
and mapping system to link and display information for a watershed.
HAZMAT has applied this approach to four pilot watershed projects:
Newark Bay, San Francisco Bay, the Christina River, and the Calcasieu
Estuary.
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HAZMAT published CAMEO. This computer program,
co-developed with EPA, addresses the needs of emergency responders
and hazard planners. The present version of CAMEO contains
information for over 4,000 commonly transported chemicals, database
templates for storing local specific chemical and planning information,
plus ALOHA, an air dispersion model that uses digitized maps
developed by the Bureau of the Census, and MARPLOT, a mapping
program. CAMEO provides the means to meet the data management
requirements of the Emergency Planning and Community Right-to-
Know Act of 1986.

Over 6,000 organizations around the world use CAMEO. The United
Nations has adopted this program to help developing countries prepare
local emergency response plans. The U.N. has introduced CAMEO to
over 50 nations. The CAMEO user community includes all levels of
government, as well as academia and private industry.

ESI  ATLASES



Contents?About the producers (cont.)

Each year HAZMAT provides training to about 100 industry, local
government, and Federal agency personnel in the scientific aspects
of oil and chemical spill response. This training, conducted in Seattle,
the Gulf of Mexico, the Northeast, and Great Lakes helps transfer the
knowledge and experience of HAZMAT scientists to the broadest
possible audience.

As part of a broad National Ocean Service effort, HAZMAT is managing
navigation safety and efficiency projects in San Francisco Bay, Puget
Sound, and Cook Inlet and Prince William Sound, Alaska. These projects
focus on activities that can help prevent maritime spills.
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Florida Department of Environmental Protection

coastal resources.  To support DEP's ecosystem-management objectives, FMRI
assesses varied tiers of environmental and biological resources within Florida's
coastal ecosystems.   Staff are currently studying marine fishery and
non-fishery populations, amounts and effects of commercial and recreational

species descriptions and life histories, plant and animal communities,
endangered and threatened species, estuarine and marine food chains,
aquatic environments, pollution events, cumulative effects of natural and
human-induced environmental changes, restoration of degraded habitats,
and use of its hatchery for fish stock restoration.

Florida Marine Research Institute (FMRI), a bureau within DEP's Division
of Marine Resources, conducts marine research and monitors Florida's

harvests, genetic and physical characteristics of organisms and populations, 
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Technical resources in St. Petersburg include computer and geographic information
systems facilities; research reference library; electron microscopes; habitat
fisheries, diagnostic, and genetic laboratories; marine mammal necropsy and 
pathobiology laboratory; biological reference collections (animals, 
microalgae, coastal plants, and living red tide and microalgae cultures); and
numerous research vessels.  FMRI headquarters consist of four buildings
and a marine dock and staging area.   The largest building, 90,000 square feet,
combines laboratories and offices and is architecturally connected through
its third floor to the University of South Florida's (USF) Department of
Marine Science.  DEP and USF share this floor, where remote-sensing and
and geographic  information systems are located.   Other joint-use space
includes a seminar room and 250-seat auditorium.
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FMRI is leading a multi-year effort updating and reprinting the
statewide series of Coastal Environmental Sensitivity Index (ESI) atlases
for Florida.  Creating digital Geographic Information System (GIS) files

atlases were created in the late 1970s to provide oil spill responders
with pertinent biological, physical, and cultural information.  This
information is used in the planning and implementation of response
strategies that minimize damage to Florida's coastal resources in
the event of an oil  spil l .   However,  these atlases are more than
fifteen years old and they no longer adequately reflect current
coastal  condit ions.

of all ESI data.  Statewide Environmental Sensitivity Index (ESI)
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The Bureau of Emergency Response (BER) has allocated money from the
Coastal Protection Fund to the Florida Marine Research Institute (FMRI)
to  do the  fo l lowing:   update  and enhance  the  informat ion
found in the existing ESI atlases; print and distribute a new set of atlases
for the BER field offices; and load the ESI information into the Marine
Resources GIS so that the information can be easily accessed
in the ARCVIEW version of  the Florida Marine Spil l  Analysis
System (FMSAS).

.
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